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Edit Game Levels

This dialog allows the Word-list creator to set:

The number of game levels players will face when using the Word-list in Spell-Mell
The names of the levels

The order in which the levels will be presented

The Word Groups from which each level will be created

When you have completed the operations described in this section, click the Approve button to make the
changes permanent. You can also use the Cancel button to return to SLED without making any changes.

Setting the number of levels

The default number of levels in a Word-list is 10. For a short, simple quiz, this is probably too many. For
some other types of game, it might be too few. (The program's internal limit is 100 levels, but that is far
too many for a reasonable game.) You can add or delete levels using the graphical buttons below the list
of level names on the left side of the dialog.

The Add Level button creates a new, unnamed level below the current level. Although Spell-Mell will
use a default name for levels you don't name yourself, an assigned name is both more useful and more
interesting for the player.

The Delete Level button removes the current level from the game. A game may have as few as two
levels.
Naming levels

To name levels individually, select a level in the list then enter/edit its name in the Level Name text box
(just above the list on the left side of the dialog).

If you want to give the same name to a number of levels, use the Name Lock button (just above the
Level Name text box). To use the button, first name one level in the usual way. While that level is still
selected, click the Name Lock button, which then will stay down until you click it again. While it is down,
click each of the levels in turn to which you want to assign the locked name. Finally, click the Name
Lock button to release it.

Changing the order of levels

Use the Move Level Up and Move Level Down buttons to re-order the list.

Click this button to move the currently-selected level up one position in the list of level names.

Click this button to move the currently-selected level down one position in the list of level names.

Assign Word Groups to levels

Each Spell-Mell level draws its questions and answers from one or more Word Groups (into which you
categorized your words in Step 6 of the Word-list authoring process. By default, all levels use the words in
Group 1 only.

To specify that a game level should take its words from a particular set of Groups, just select those



Groups (using the list on the right-hand side of the dialog) while the level name is selected. You can also
deselect any Group by clicking it again.

The Groups menu in this dialog provides Select All and Select None commands that cause all or none of
the Word Groups to be selected. There is also an Extended Select command. While this is checked, the
Groups list supports Windows' "extended selection”, in which the Ctrl and Shift keys have special roles in
list selection. Consult your Window documentation if you aren't sure how Extended Selection works.

If you want several levels to use the same combination of Groups, use the Group Lock button (just
above the Groups list). To use the button, first set up the selection of Groups for one level in the usual
way. While that level is still selected, click the Group Lock button, which then will stay down until you
click it again. While it is down, click each of the levels in turn to which you want to assign the locked
combination of Groups. Finally, click the Group Lock button to release it.



Edit Group Names

The Edit Group Names dialog lets you assign meaningful names to Word Groups, which by default have
only numbers (from 1 - 100).

Group names are not seen by the Spell-Mell player. The only function of Groups is to make it possible for
the Word-list creator to assign certain categories of words or phrases to the "levels" the player will
encounter in the game. How that works is described in the section of this help file dealing with the Game
Level Editor.

It is unlikely that you will need to use more than a small number of Groups - perhaps twenty at most - in
any ordinary Word-list.

To name a Group, simply select it in the Group list on the left side of the dialog, then enter or edit the
name of the group in the edit box on the right.

When you have finished naming Groups, click the Approve button to return to SLED. Click the Cancel
button if you want to return to SLED without making any changes to Groups.



Information for Unregistered Users

Important Note: SLED will let you create and edit word-lists, and will let you save your work, even if you
have not yet registered your copy of the Spell-Mell game. However, Spell-Mell will let you play only the
first level of a word-list created from an unregistered copy. After you have registered, just load the word-
listinto SLED and save it again. From then on, any registered copy of Spell-Mell will be able to use your

word-list.



Overview

Welcome to SLED, the Spell-Mell List Editor.

The purpose of SLED is to help you create or edit game modules called Word-lists, which can then be
played by yourself and others within the Spell-Mell game.

You can work through the creation of a Word-list by following the six steps listed in the Table of Contents,
each of which corresponds to a "page" in the SLED window. At any time during both your first and
subsequent sessions, you can revisit any of the steps using the Next and Previous buttons to expand or
refine your work.

A word-list can be very simple. It can even be a literal list of words, which Spell-Mell will use as the basis
for an Anagram Quiz. Or it can be more elaborate, for example:

A trivia quiz with a number of subtopics, organized into levels;
A study quiz, that will help the player master a particular set of words, names or facts;

A full-blown foreign vocabulary quiz, with parallel vocabularies of words in as many languages as you
like.

Whether your word-list is simple or elaborate, whether it has an educational purpose, or is purely for fun,
SLED helps make the job easy and painless, even if you want to use advanced features like:

Using a password to prevent others from editing the word-list (good for teachers!)
Providing translations of titles and other text for International users
Inserting your web-page URL so players can actually link to your page from within Spell-Mell itself.

For help in using SLED, use the Help / Help with this page menu command (or press F1) while using the
program, or simply browse this short help file using the browse buttons in the tool-bar.



Sharing your Word-lists

When you have a completed quiz, or other Word-list, and have tested it thoroughly, you might like to
share it with others. One way to do that is to email a copy of your Word-List to us at Family Games. We'll
look it over, and if we feel it's appropriate, we'll post it on our web-site for other Spell-Mell users around
the world to download.



Special characters

To meet the needs of the various languages used for the supplied foreign vocabularies, Spell-Mell
supports most of the characters in the Windows standard set, plus some from the Central European set.
The latter must be entered into SLED using special key sequences detailed below.

The standard Windows characters supported by SLED are:

The Central European characters, and the key sequences used to obtain them, are:

To get Use ">" + To get Use ">" + To get Use ">" + To get Use ">" +

this: this: this: this: this: this: this: this:

A A a a A A a a
Alt+0196 Alt+0228

¢ ¢« & < ¢ ¢ ¢
Alt+0199 Alt+0231

D D d d 6 o F )

E E e e E E é é
Alt+0203 Alt+0235

L L | | L £ i i
Alt+0163

N N n n N N i i
Alt+0209 Alt+0241

R R r r R ? i /

S S S s S S $ g
Alt+0138 Alt+0154

T T t t T v t oy
Alt+0221 Alt+0253

[+] T . .

U U i u v 0 ii i
Alt+0220 Alt+0252

2 Z 3 z 2 { i [






Step 1: Welcome

The opening "page" of SLED contains a "Welcome" message and a panel of buttons that let you choose
your working language for both SLED and the Spell-Mell game.

The next step is to choose a command from the File menu. Choose New to create a new word-list;
choose Open to load an existing word-list for editing. Either command will advance you to Step 2: Word-

list Type and Title.



Step 2: Word-list Type and Title

Your first concern when creating a new Word-list is to select its type from the three available choices:

The Quiz type is the most usual choice, and the most versatile type of Word-list. Use this to make
ordinary trivia quizzes with questions and short answers, vocabulary and spelling games where the
player must find the word or phrase to match the definition you have provided; and puzzle games
where the question is a clue - perhaps a rather indirect one - to the answer. Examples of all three types
will be found among the Word-lists in the release version of Spell-Mell.

A poisonous lizard!
g lla| |mjo| [s|t]e|r

The Anagram type of Word-list is the easiest to create. You simply enter a list of words into
SLED. You can add clues, if you want, or set up your list so that particular words will appear at particular
levels in the game, but these steps are optional. Spell-Mell will randomly scramble the words for the
player, who must then try to restore them.

talssoabr: Has the largest wing-span

.|I h|.|t rio|s|s

A Foreign Vocabulary Word-list is more specialized. In this case you supply a vocabulary of words
in two or more languages. The Spell-Mell player selects which language is to be used for the clues, and
which for the answers, and the game configures itself accordingly. The vocabulary Word-list in the release
version of Spell-Mell includes nearly 300 words in over a dozen languages.

butterfly
miar| [plo|s|a

Changing the type of a Word-List

Important: You can freely use the Word-List Type buttons to convert a Quiz Word-list to an Anagram one
and vice versa. However, if try to change a Foreign Vocabulary Word-list to one of the other types, or vice
versa, all the clues and answers in the list will be lost in the conversion.

Naming your Word-list

The Title you enter for your Word-list should be carefully chosen, as this is what players will see in Spell-
Mell's Game Menu. To differentiate your Word-list from all others, be as specific as your topic allows. If
your topic is a very general one, distinguish your title in some way (e.g. Mary's Football Quiz) to make it
stand out from the crowd.

For the benefit of players in other countries, you may also wish to provide translations of your title. If the
player's working language matches one of the translations, that text will be used instead of the main title.
Use the Game/Iranslate... menu command if you want to work on translations.

The Next Step

When you have finished with the Word-list type and title controls, click the Next button to advance to Step
3: Author Information, Password and Version.




Step 3: Author Information, Password and Version

What is your name or nickname?

The Game Menu in Spell-Mell lists the available Word-lists by Title (see Step 2) and Creator. Enter your
name (use a nickname or pseudonym, if you prefer) as the creator of the Word-list.

Enter any additional information about yourself:

This box is used for contact and copyright information. Players can review what you enter here by clicking
the Information button on the Spell-Mell Start screen.

TIP: If you have web-site you would like to promote, put the URL in this box, making sure to start it with
"http://". This will display in Spell-Mell as a live URL that players can click on to launch their browser and
visit your web-site from within the game itself. You can include an email link in the same manner. Just
include "mailto:" plus your full email address somewhere in the text, e.g.:

Contact us by clicking here: mailto:njs@familygames.com

Password

If you want to prevent other people from loading your Word-list into SLED, you may protect it by entering

a password in this box. This feature might be particularly appropriate in group situations, such as schools,
where one person may need to maintain exclusive control over the contents of the Word-lists used by the
group.

WARNING: Make sure the password is one that others will not guess, but that you will be sure to
remember. Otherwise, you may find yourself in the awkward position of being unable to load your own
Word-list!

Version

Enter your version information in the space provided. The version number comes in two parts, separated
by a period (e.g. 2.3). The major version, which defaults to one in a new Word-list, should be incremented
each time you release a version of the Word-list with important changes, such as additional clues and
answers, or after a major revision. The minor version, which defaults to zero in a new Word-list, and
should be reset to zero when the major version changes, is incremented when you make small changes
such as correcting a typographical error.

At present, Spell-Mell does not use or display the version information - it is for the Word-list creator's
benefit only - but this may change in future releases.

The Next Step
When you have finished with the controls on this page, click the Next button to advance to Step 4: Word-
list Description and Notes.



Step 4: Word-list Description and Notes

Describe your Word-list

In this space you can enter up to four lines of description of your Word-list. Players will see this
description when they are browsing through the menu of available Word-lists in Spell-Mell, so you should
try to provide as accurate an impression as possible of what they can expect.

For the benefit of players in other countries, you may also wish to provide translations of your description.
If the player's working language matches one of the translations, that text will be used instead of the
description you enter in this step. Use the Game/Translate... menu command if you want to work on
translations.

Additional notes

The optional notes you enter in this space can be viewed from within Spell-Mell by clicking the
Information button after your Word-list has been opened. It's a good place for background information,
references, and general commentary that may be of interest either to players or other Word-list authors.

As with the Author information in Step 3, you can include live web site URLs and email addresses in this
text. One use of this is to provide references to web sites you may have used in researching a Word-list.

The Next Step
When you have finished with the controls on this page, click the Next button to advance to Step 5a:
Select Word-list Language.



Step 5a: Select Word-list Language

What language are you using?

From the list at left, select the language for the current Word-list. The languages in this list are those for
which the language names are known to SLED, and so will be listed in your Working Language.

For a Quiz or Anagram Word-list, this should be the language you will be using for the clues and answers.

For a Foreign Vocabulary Word-list, this is your primary language - generally the one in which you
yourself are most comfortable. If you change your choice of primary language later on, your original
choice becomes a secondary language (Step 5b), and your new choice is either promoted from
secondary to primary, or created as a new, empty vocabulary as applicable.

More languages

If your preferred language is not among those known to SLED, select it from the list at right, using the
Add button if needed to add the language name to the list. You can also use the Modify (rename) and
Delete buttons to further edit this list as required.

The only difference between the languages listed on the right and those on the left, is that the names of
those on the right will not be translated when you change Working Languages.

The Next Step

When you have finished with the controls on this page, click the Next button to advance to the next step.
If you are working on a Quiz or Anagram Word-list, the next step is Step 6a: Enter Clues and Answers. If
you are working on a Foreign Vocabulary Word-list, the next step is Step 5b: Select Secondary

Languages.



Step 5b: Select Secondary Languages

The controls on this page are only available when editing a Foreign Vocabulary Word-list. The only
difference between these controls and those in Step 5a is that the lists here allow you to select multiple
languages.

Each language you select causes a new empty vocabulary to be created for that language. For a Speli-
Mell player to actually use your Word-list, you will need to add vocabulary in at least one secondary
language.

Warning: If you deselect a language on which you have already worked, any vocabulary you have
entered will be lost upon leaving this page. SLED will ask for confirmation before carrying out the deletion
for each selected language.

The Next Step

You are now ready for the last of the six steps in creating a Foreign Vocabulary Word-list: Step 6b: Enter
Vocabulary.



Step 6a: Enter Clues and Answers

Let's assume you have just created a new Quiz Word-list, and that the topic of your Quiz will be
"Canada". Now you have come to the step where you will actually enter the questions and answers that
the player will see when your Word-list is opened in Spell-Mell.

On the right-hand side of the SLED page you will see an empty list. This is the Answer List, where your
quiz answers will go. Let's begin by adding the following question and answer:

Question: In which Canadian city is AHA! Software based?
Answer: Victoria

Click in the space labeled "Answer:", and type "Victoria". Now click the space inside the "Clue" box (or
press the Tab key a few times until you see your cursor there) and type "In which Canadian city is AHA!
Software based?". Finally, press Enter, or click the Add button.

You should see the answer appear in the Answer List, and your cursor should jump back to the "Answer:"
space ready for you to enter another one. Here are a few more questions and answers you can add:

Question:  Which province is Alberta's neighbor to the west?
Answer: Saskatchewan

Question: What is the capital city of Canada?
Answer: Ottawa

Question:  Which province joined Canada most recently?
Answer: Nova Scotia

Question: Which is Canada's tallest mountain?
Answer: Mount Logan

To review your work, click on each of the answers in the Answer List in succession. You will see that the
both the answer and the corresponding clue appear in their spaces on the left of the page for further
editing.

Simple editing

You might observe at this point that we have made a couple of careless errors. Let's fix these before
continuing.

First, Saskatchewan lies to the east of Alberta, not the west. To correct the erroneous clue, just click
"Saskatchewan" in the Answer List, then edit the question in the Clue box. You don't have to do anything
else to complete this operation, because any change you make in the Clue box is "hot": it instantly
changes the actual clue for the answer currently displayed in the "Answer:" box. To verify that your
change was made successfully, click another answer, then click "Saskatchewan" again. You will see that
the change you made to the clue has been preserved.

Our second error is the answer to the question about which province joined Canada most recently. The
correct answer is actually "Newfoundland". To make the needed change, first click "Nova Scotia" in the
Answer List, then edit the "Answer:" box to read "Newfoundland". This is where the Change button - the
small one with the rightward-pointing hand - comes into play. It must be used when you want to change
an existing answer rather than adding a new one. Click it now, and you will see "Nova Scotia" change to
"Newfoundland" in the Answer List.



The Delete button, as you have probably guessed, removes the current answer from the Answer List.

Groups

The remaining control on this page is the Group drop-down list. It is often a good idea to assign the
answers in a Word-list to different groups. Later on, you can specify (using the Game/Edit Levels... menu
command) that the answers used by individual levels of a Spell-Mell game should be drawn from one or
more particular word groups.

You can assign any word to one of up to 100 groups (though normally you will use far fewer). At first the
groups are identified simply by a number from 1 to 100, but you can given them any names you like using

the Options/Edit Group Names... menu command.

As a last step with our Canada Word-List, let's assign the Answers to groups. So far our quiz has two
questions relating to cities, two relating to provinces, and a fifth question about Mount Logan. Currently,
all the answers are in the default group, Group 1.

Let's make Group 1 the "Cities" group, Group 2 the "Provinces" group, and Group 3 the "Geographical
Features" group. We may decide to add more groups in future as the quiz grows, but these three are
enough for now.

We don't need to assign the first or third answers ("Victoria", "Ottawa") to a different group - they are
already where they belong - so let's start with the provinces. Click on "Saskatchewan" in the Answer List,
then select "02" in the Group drop-down list. As with clues, the assignment of a group is "hot" - you don't
need to do anything else to complete the operation. Click on "Newfoundland", and again select "02" in the
Group list; and finally click on "Mount Logan" and select "03".

Anagram Lists

Though we have focused in this section on authoring a quiz, the process of creating an Anagram List is
virtually identical. The only important difference from the quiz creator's point of view is that in an Anagram
List the clues are optional. Check out our two Jumbled Words quizzes to get a feel for way clues can be
used in an Anagram List.

What's Next?

If you have been following along with the process of creating the Canada quiz, this would be a good time
to save your work using the File/Save As... menu command. A good name for the file would be
"Canada.smw". As soon as it's saved, you should be able to load the quiz into Spell-Mell to verify that it's
working so far.

If you were to work on the Canada quiz further, the next step might be to edit the group names, as noted
above, so that you don't have to keep track of the groups by number. You might like to start mapping out
the levels of your quiz, also mentioned above. You will certainly need more questions - at least five for
each level of your quiz, since Spell-Mell displays five questions at a time (if you have less, Spell-Mell will
re-use questions it has asked already).

Finally, you might like to go back and do some more work on the Author Information, Description, and
other areas discussed in the previous steps.



Step 6b: Enter Vocabulary

The only important difference in the steps for adding to a Foreign Vocabulary Word-list, rather than one of
the other types, is that each answer can have multiple "clues" - one for each additional language for
which you have decided to provide a parallel vocabulary. These are added using a Grid that lists each
secondary language name along with a space for each corresponding vocabulary entry.

You should become familiar with the process of adding questions and answers to a Quiz Word-list, by
working through the mini-tutorial in Step 6a, before embarking on a Foreign Vocabulary Word-list. Once
you have mastered the various controls - the Add, Change and Delete buttons, and the Group drop-down
list - you will find it a simple matter to adapt what you have learned to this new context.

Untranslated words

Sometimes you may want to leave a "hole" in one of the vocabularies, usually because a particular term
defies translation. This is perfectly all right. Simply leave the space blank where that word would have
been entered in the language's vocabulary, and Spell-Mell will not use it in games where that language is
involved.

Words with two meanings (homonyms)

Sometimes, as with the English word "orange", the same word may have two quite different senses. In
some contexts, this isn't a problem at all. For instance, you may be using the word on a Spell-Mell level
that contains only the names of fruits, or only the names of colors.

In other cases, you must use additional text to clarify the meaning. This text should be placed inside
braces ("curly brackets") after the word, as follows:

orange {color}
orange {fruit}

When Spell-Mell displays the word to the player as a clue, the text in braces will be shown in ordinary
parentheses. When the word is used as an answer, however, the text in the braces is not needed, and so
is omitted altogether.



The File Menu

The items on this menu should be quite familiar to users of standard Windows applications. Here is a brief
summary, noting points of interest to SLED users:

File /| New

Creates a new Word-list. Follow the 6 Steps outlined in this help file to set the type of the Word-list, set a
title and other auxiliary information, and add questions and answers. Finally, use File/Save As... to store
the newly-created Word-list to your hard drive.

File / Open...

Displays a standard Open dialog, displaying the Spell-Mell Word-lists in the directory (folder) you most
recently used in an Open or Save operation. Word-list files have the file extension ".smw".

Normally you should store all your Word-lists in the default location (the "lists" subdirectory within your

Spell-Mell installation), since it is only here that Spell-Mell itself will be able to find them. Occasionally,
however, you may want to store a Word-list in another location, either for back-up or for transport (via a
removable disk) to another computer.

If you attempt to open a password-protected file, you will be asked to provide the password before the
operation completes.

To preserve any changes you make to an opened Word-list, you must save it back to disk before
performing a New, another Open, or closing SLED. (You will be warned if there are unsaved changes at
those times.)

File / Save
Saves the currently open Word-list under its current name and to its original location.

File / Save As...

Displays a standard Save dialog to let you save the currently-open Word-list under a new name or to a
new location. (This is the only Save option available for newly-created Word-lists.) Normally you should
store all your Word-lists to the default location, as noted above under File/Open.

Exit

Closes SLED. You are warned if there are unsaved changes to your current Word-list.



The Game Menu

This menu lets you work on some of the auxiliary text seen by the Spell-Mell player who is using your
Word-list. It has just two commands:

Game / Edit Levels...

This invokes the Edit Game Levels dialog, which lets you specify how many levels a Spell-Mell game
using your Word-list should be allowed to run, what the level names should be, and which word groups
should be employed on each level.

Game / Translate...

This invokes the Translate Game Text dialog, which lets you reach a wider international audience for your
Word-lists by providing translations of the Word-list title, description and level names.



The Help Menu

This menu lets you access SLED's on-line help, and the About dialog. The commands are:

Help / Topics
This command opens SLED's on-line help and displays the Contents page.

Help / Help with this page

This command opens SLED's on-line help and displays the section pertaining to the current page or
"step". It is equivalent to pressing the F1 key while using SLED.

Help / About...
The SLED About dialog is displayed. Click the Close button when you are ready to return to SLED.



The Options Menu

The commands on this menu let you set various options while working with a Word-list.

Options / Working Language

This menu command opens up a sub-menu from which you can select your Working Language at any
time while using SLED. The languages offered are the same as those on the Welcome page (Step 1).

Options / Sort

This menu command is available only while editing the questions and answers (or vocabularies) used by
your Word-list. It opens a sub-menu offering two choices:

Alphabetically: The Answer List is sorted alphabetically.
By Groups: The Answer List sorted by word groups.

The sorting operations affect only the answers currently displayed. If you add more answers, they will be
simply added to the end of the list as usual. Nor is the sorting permanent. If you go to a different SLED
page, then return to the Answer List, you will find that it has reverted to its original chronological order.

Edit Group Names

This menu command is available only while editing the questions and answers (or vocabularies) used by
your Word-list. It invokes the Edit Group Names dialog, which lets you assign meaningful names to the list
of numerical Word Groups used for categorizing the answers in your Word-list.



Translate Game Text

You can take advantage of the international nature of Spell-Mell to provide translations of your game text
for the benefit of players in other countries. If you are able to provide translations, this dialog centralizes
the task for all three kinds of text for which translation is supported. When a player's selected Working
Language matches one of the languages for which you have provided a translation, Spell-Mell displays
the translated text rather than the main text.

The first step is to decide which languages you want to provide translations in. Select these from the
Languages available list at the top left of the dialog.

After selecting a language, click the Use Language button. The selected language jumps over to the
Languages selected list at the top right of the dialog.

If you change your mind about a given language, click its name in the Languages selected list, then
click the Delete Language button. After confirming that this is really what you want to do, SLED moves
the selected language back to the Languages available list. Any translation you have done in the
deleted language is lost.

After highlighting a language name in the Languages selected list, choose one of the three tabs on the
dialog (Title, Description, or Level names) according to the kind of text you want to edit.

Editing the Title

The Word-list title you have entered in your default language is displayed below an edit box in which you
can enter the translated title in the selected additional language.

Editing the Description

Here again the original text appears below the area in which you provide the translation. Like the original
text, the translation should have at most four lines, since the description would otherwise be cut off when
displayed by Spell-Mell.

Editing the Level Names

The current set of level names is displayed as the left column of a grid. Use the grid's right-hand column
to enter the translation of names in the currently selected language.

Changing the Default Language

If you wish to change your default language, for some reason, open the Options/Default Language
submenu of language names. The new selection then becomes the default language for your game text -
the one that is used when none of the languages you provide matches the player's Working Language.
The former default language is demoted to a secondary language, but its translations are not lost.

Closing the Dialog

The Translate Game Text dialog does not provide a Cancel button. The changes you make here take
effect immediately. Click the Close button when you are ready to return to SLED.



Word-lists with Icons

For technical reasons, the ability to use icons in a user-created Word-list is not currently included in
SLED. Such a Word-list can be created "at the factory", as you can see from the vocabulary Word-list
supplied with the release version of the Spell-Mell.

If you have a good idea for a Foreign Vocabulary or Quiz Word-list that requires icons, and can supply the
icons themselves, get in touch with us by email and we will try to help you out.



The Working Language is the one used for the program text, messages and documentation. Within Spell-
Mell, the working language is also used for some other text such as Word-list descriptions and level
names, if the necessary translations were supplied by the word-list creator.






